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Section 1 Introduction

Product Overview
These release notes describe patch 13 for Enterprise Historian History Services 
version 2.4 for the HP-UX platform. 

This patch can be applied to systems with Enterprise Historian version 2.2, or 
OS1.8/nPm where n = any version of OS 1.8, and m = any patch. The patch is all-
inclusive so it can be applied to History version 2.4 at any patch level.

The problems fixed by this patch are described in Section 2, Functionality. 
Instructions for installing this patch are provided in Section 3, Installation.

Prerequisites and Requirements
The History Services software on the Enterprise Historian or Operator Station 
platform must be at Version 2.4 to install this patch. 
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Section 2 Functionality

Fixed Problems
Table 1 describes the problems that are fixed by patch 13. Problems fixed by earlier 
patches which are also included in this patch are described in Table 2 through 
Table 10.

Table 1. Problems Fixed by Patch 13

ID Description

2015 Prior to this patch, when a remote system had a server that was hung, a response 
was never returned to the omf client. This problem has been fixed.

1577 The memory leak problem in hsLogMan (hsLogMan grows when UserAPI modifies a 
numeric log) has been fixed.

2256 Prior to this patch when the event log was configured to collect just process section 0 
messages, it collected ALL messages. The event log now collects just the specified 
messages. 

2223   hsPDLstorage oracle warnings are now reported as errors.

2071   Requests to activate/deactivate logs through RTS display sometimes failed on first 
try. Such requests are now successful on the first try.

2016 Collection no longer crashes when a secondary log is deactivated.

2014 Date/time handling has been corrected to support compatibility with the Enterprise 
Historian 3.2/1 on the Windows platform.

2013 A script is now provided to create the ops$ocshis user on the Enterprise Historian 2.2 
platform to support PDL consolidation on the Information Manager 3.5 Enterprise 
Edition. The procedure for running the script and setting up PDL consolidation is 
described in Inform IT Scheduling Services Configuration. 

2012 Entries in the log_source table are now deleted as they should be when composite 
logs are deleted. 
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2011 printf for generic errors has been corrected so that dbConfig, history builder, and 
other tools that use this function no longer crash on such errors.

1685 In patch 12, hsBAR was changed to not allow backup of a running system with PDL 
configured. hsBAR aborted the backup if History was running. This interlock was 
implemented to prevent inconsistencies that could occur in a backup image when the 
backup was done at the same time PDL data was being collected and stored. 

Patch 13 removes this interlock so that on-line backups are now permitted. If you are 
using PDL and you perform an on-line backup, it is possible that the data stored 
during the backup will not be consistent. If this occurs, the subsequent restore may 
have a problem enabling constraints on the PDL tables. 

Check the hsBAR log file for constraint errors after every hsBAR restore opreration.

If you attempted an on-line backup while collecting PDL data, and you have problems 
restoring the data, contact the Technical Support Group via SUPPORTLINE - U.S.: 
(1-800-HELP-365); International: (1-614-224-5888).

One possible work-around for future back-up operations is to pause TCL and/or 
Batch 300 while hsBAR is executing.

1513 Prior to this patch, when archive attempts for an archive group failed to the point 
where the archive buffer size exceeded the space available on any archive volume, 
all archive volumes would be marked as full (even though they may be empty).

Now, if History is trying to archive data from a time interval that is greater than 2 
scheduled archives, the end time for the archive group is reset to allow the archive to 
fit on an archive volume.

2300 The problem that caused the hsLogMan process to crash unexpectedly has been 
fixed.

Table 1. Problems Fixed by Patch 13

ID Description
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Table 2. Problems Fixed by Patch 12

ID Description

1457 Corrected section filter conversion for Event Log configuration.

1446 Changed LogSet display to correctly display states.

1432 Corrected collection crash when deactivating a dual log which is failing over. 

1428 Corrected parsing issues with dbChanges file.

1409 Corrected restore of PDL modify columns. 

1399 Data is stored correctly for Eventlogs messages. This is fixed by the post 
installation procedure described in Post Installation on page 25.

378 Previously PDL was corrupted after restore from hsBAR, if History was 
running while the backup was being created. Now hsBAR will not allow History 
back up with PDL while the system is running. 

1374 Fixed crash that occurred when activating user-supplied log.

1352 Conversion will no longer corrupt numeric data for large logs when conversion 
is executed twice.

1327 History config can now be migrated to Enterprise Historian 3.2/1. 

1313 Retrieval of next entry when countRequest is specified no longer fails.

1312 When restoring a log, verify that corresponding runtime log exists.

Table 3. Problems Fixed By History 2.4 Patch 11

ID Description

829 In history builder the Archive -> View Report logs option now works correctly, so 
you can search for reports in view report log window. 

893 Archive volume transition no longer halts if the first archive after it returns a failure. 
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895 The Update Status command in RTS display no longer waits for History to restart.

905 dbconfig no longer crashes on load when secondary log exists with no primary log. 

920 The dbConfig stats output, created when checking dbLoad files, now adjusts the 
Oracle space needed for OPC/Audit message logs.

960 Audit Trail Log no longer causes the History Builder to crash with the following error: 
"hsBuilder.exe has generated errors and will be closed by Windows. You will need to 
restart the program. An error log has been generated." 

1002 When restoring any data from any archive, hsArchive will not crash. 

1048 hsArchive process no longer closes STDIN handle. 

1176 Running PDL and Reports through TCL statements no longer causes 
hsModInterface to crash when a PDL 'end batch' and a Report command are sent 
very close to each other. 

1180 MOD 300 timestamps are now reported correctly(no longer off by 1 hour) when 
times older than the last time change are passed from the ModInterface. 

1191 Deleting a report log now deletes reports in Oracle and tablespace used by that log 
is freed up. 

1226 Conversion no longer fails for PDL upgrade. 

1239 When merging data directories, hsBAR now correctly updates size quotas

1251 hsBAR backup now works correctly for MasterOS.

1253 resource occurrence can be a random number. When recording resource 
Associations from the hsModInterface, it is possible that the occurrence number is 
not zero. This is occurring because the typeDir treats the values as an output 
parameter only. Since the value is always zero for this transaction, the value can be 
force to zero inside PDLstorage 

Table 3. Problems Fixed By History 2.4 Patch 11

ID Description
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Table 4. Problems Fixed by History 2.4 Patch 10

ID Description

216 In cases where only one numeric log exists in a composite log and no CCF or PHL 
logs are defined (or the time span for the request is outside the timespan 
supported by PHL or CCF), the logManager will not switch to the restored log, if 
available, when the accessName is the requested name. (BaseHistory, MOD 300 
only).

431 On MOD300 CDP nodes, a timing issue between the start of MTOS and the OMF 
tasks on the RTAB can cause the OMF in the host OS (NT or UNIX) to fail to 
resubcribe on Node UP for the RTAB. This prevent the logManager from seeing 
ALL MOD300 nodes (history and controllers) on the DCN. When this occurs, no 
trend data can be retrieved from the logManager. (BaseHistory and History, 
MOD 300 only)

460 Bulk Data Export fails when getting more than 3200 raw data values.

461 BDX loses parameter default values.

462 BDX cannot get raw data for a single synchronous log, nor can it get interpolated 
data for a single asynchronous log. Two or more logs must be specified to have 
raw data returned.

489 Fixed crash in History Builder when filtering entries in View Archive Media window. 
Also removed time field in filter and search dialogs for log entries as that field 
appears to be completely useless.

495 hsModInterface crash with dead messages. This could occur using PDL when the 
Start_Batch message was missed. The END_BATCH would not cause the interim 
messages to be stored in PDL, and the hsModInterface process would eventually 
fail.

503 Activating a log and then deactivating before it goes from pending to active, 
causes the log to go to translating and stay there. Attempting to deactivate again 
causes a dialog saying that it is already not active.
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604 Auto archiving of Profile PDL data on Batch end has been seen to not work on 
occasion. The problem is resolved by restarting History at which point all the PDLs 
that could not be archived at their appointed time are archived (MOD 300 and 
Profiles only).

605 An auto/manual archive of a PDL containing associations to multiple Profile Logs 
only contains archive data for the PDL and the first log in the association. The 
other logs, even though they contain data, have no data in the archive entry. (MOD 
300 and Profiles only).

672 In AdvancedHistoryBuilder, if the user chooses tools>global messages and tries 
to choose edit>clear the program will crash. This only happens if there is at least 
one message in the display.

673 Fix dbConfig crash when like log name matches one of the names of a fully 
configured log.

704 Remove composite log typical object from history server runtime tables when last 
log in a typical is deleted.

If a new log with a typical is created and the typical name is the same as the old 
one, History Builder will report an error saying that the name already exists, even 
though it was deleted.

714 Corrected purge future dates to work properly with files that have super index 
block. Also added a utility option to fix the files that have been corrupted with the 
“hsDBMaint -purge” before this fix was applied.

715 When asking for data in time range completely after any log data, “hsDBMaint -
bdx” has a potential of crashing or simply not returning what it is supposed to 
return, which is NoData points for the entire requested interval.

719 If Directory Maintenance window is opened on a node that has no directories 
configured in history or if all directories are deleted from that window, the builder 
will crash.

729 dbConfig crashed because a compaction ratio had decimals (like 0.0178) in it.

Table 4. Problems Fixed by History 2.4 Patch 10

ID Description
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738 When in the composite log view and the user selects File->Open, the dialog 
shows all the logs but the Filter Logs, Search Logs, and Refresh List buttons are 
all grayed out and disabled.

755 BDX incorrect permissions does not allow raw data export to be used for Data 
Reconciliation client applications or other client applications.

760 Fixed crash in hsServer when retrieving list of logs in a logs in log sets and second 
log set is empty.

761 If newly created composite log is the first composite log, it may fail to show up in 
the Open Composite Log dialog box after it has been saved.

765 dbConfig changes option does not reset next index when the logCapacity is 
modified. This can cause data corruption of the numeric logs when trying to 
increase the log capacity.

775 hsLogMan includes CCF/PHL when trying to resolve requests from MOD 
consoles. This can result in an 8 second time-out for each trace on a MOD 
console, delaying data returned for almost 2 minutes (12 traces * 8 =96 seconds). 
(BaseHistory, MOD 300 only).

779 Modify operations are not accepted by hsServer. Allow debug in hsPDLStorage.

780 Increased surface limit for Jukebox archive to the maximum supported number, 
64.

792 Report requests that are issued at the end of Batch 300 batches are preventing 
PDL data from being stored and hence archived by the Enterprise Historian.

799 If archive fails to write out an automatically scheduled PDL, history server never 
reschedules the PDL to archive again. It will also not schedule any more automatic 
PDL archives. Once in this state, the only way to correct the situation is to restart 
History. 

805 Diagnostic errors occur when modifying PDL task variables.

Table 4. Problems Fixed by History 2.4 Patch 10

ID Description
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819 The dcHistoryRestore script provided by history for the Master OSHS fails. This 
occurs because the -s option for hsBAR should not have been included in the 
script.

822 During an upgrade of History from 2.2/0 to 2.4/0, the UpgradeHistory220 script 
failed to convert a large table (750,000 entries). The temporary tablespace created 
for the table was not large enough. The fix is to have the system calculate the size 
of the temporary table needed before the conversion task is run, and build the 
table based on those results.

Table 5. Problems Fixed by History 2.4 Patch 9

ID Description

429 When creating an Event log, you can specify which process sections to collect 
events from. This works only if you configure it correctly the first time. If you adjust 
the sections (i.e., go from ALL to just section 1), you still get the events for the 
original settings.

448 When the status of an object from which history is collecting changes to bad 
status, client is not aware that there is a problem because the last history value 
subscription updates only if the last value is good. History keeps the last known 
good value and ignores everything that is coming in.

455 It was possible for dbConfig to allow a configuration of a log hierarchy where the 
secondary logs were not collecting from a log with an access name different from 
the composite log access name.

463 When collecting remote event log across a gateway, the communication may fail, 
causing a time-out. The remote eventlog time out is 90 minutes. During this time, 
no other event requests are made, including to the local RTA board, thus no local 
events are collected during this time either.

Table 4. Problems Fixed by History 2.4 Patch 10

ID Description
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464 Deleted event logs will still stay active (until the Enterprise Historian is restarted) 
and write events to the Event Log table.

472 Instead of being directed to the screen, output of history utilities is erroneously 
directed to the log file.

473 The message quality time status bit (Uncertain) is not stored in the Event Log.

474 When the templet for a series of composite logs is deleted, the correct name is not 
picked to update the composite log typical.

486 dbDump would give a lot of warnings about attributes not being valid for the 
changes file when dumping logs with typicals, even though those attributes were 
not going to the changes file in the first place.

Table 6. Problems Fixed by History 2.4 Patch 8

ID Description

90 Bulk Data Export does not produce an error file if no input file is specified.

243 Bulk Data Export treats future invalid data as valid data.

269 Data Forwarding of Distributed Log data can be disconnected and remain this way. 
Fixed by reconnecting to source node if no distributed messages are received 
after 4 hours.

387 & 389 Prevent crash or looping of hsCollection on Console node when source node for 
distributed logs sends a disconnect.

399 Prevent storage from hanging when distributed logs are more than 32768 values 
behind the source logs.

402 HP-UX consolidation node collecting distributed logs can receive an incorrect 
message length when Historian network node disconnects for any reason. This 
can cause the consolidation history server to restart or hang.

Table 5. Problems Fixed by History 2.4 Patch 9

ID Description
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407 Fixed dbConfig to correctly dump logs with templates where the template log is not 
the first one to be retrieved for a given template. Also modified the changes file to 
only contain attributes that are valid for the changes file to contain in the first place.

413 History software did not support the ability to subscribe to the last stored history 
value using the access name.

415 It is possible to put hscollection into an infinite while loop when deactivating more 
than one log in a single request (using Runtime Status, for example). For this 
infinite loop to occur, the logs being deactivated must have distributed logs from 
two different remote nodes currently active.

418 If an archive entry has more than 32,000 log entries, View Media window in History 
Builder will fail to display any of them. A temporary fix ups the limit to 64000 log 
entries by changing local variable type to unsigned.

419 PDL Maintenance option is an off line tool used to clean up PDL tables, applicable 
only to History 2.2 systems. Option was removed.

423 Correct problem using Create User Index functionality which does not allow the 
columns indexed to exceed 32 characters.

433 Bulk Data Export retrieval functions were moved into a shared library to improve 
code support.

435 The Reset Archive Groups window was enabled in the history builder. This 
supports manual archive recovery if the archive file becomes too large.

436 Bulk data export can now work with Raw data from asynchronous logs. This was 
required for Pavilion support.

444 Restoration of PDL logs will fail when total number of history associations exceeds 
256.

Table 6. Problems Fixed by History 2.4 Patch 8

ID Description
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Table 7. Problems Fixed by History 2.4 Patch 7

ID Description

284 Each time a file open is done for composite logs, the History Builder reads all the 
names from the selected nodes and sorts them. The time to read them, especially 
from remote nodes, and time to sort them makes the History builder very difficult, if 
not impossible, to use in systems with more than 30,000 logs.

286 1. On the View Archive Device, the field called “state” refers to the same 
information that is called “Mode” on the Archive Device Window.
2. The “State” and “Active Volume” information is not in agreement with the “Mode” 
and “Active Volume” fields on the Archive Device Window. For example, on the 
View Archive Device, the State field indicated Vol-Change and the Active Volume 
field indicated volume # 20, while on the Archive Device Window the Mode 
indicated archiving and Active Volume field indicated Volume # 21.

287 On a station where there are ~90,000 logs, when you select View Log window and 
then select Retrieve by Location, the View Log and History Builder windows will 
crash.

288 While testing mo archive device configuration, the Active Volume was set to 21, 
the Volume field was set to 15, and the Volume field and Active Volume field turned 
red. The Volume Field was changed to 22 and the Active volume showed 1 instead 
of being set back to 21, which was the original active volume.

353 Due to the 20 character limitation in Master OMF name translations, the names 
used by the History Builder to create/view history configurations will become 
unusable when the history name exceeds 20 chars. This occurs when the network 
address exceeds 5 characters. 

359 hsDBMaint -report -f was an option that fixed a specific problem with History flat 
files in the initial release, History2.1. Instead of removing the option, this option will 
now erroneously perform the equivalent of hsDBMaint -restore -f on each log in 
difficultly, as reported by hsDBMaint -report. This effectively re-initializes the log, 
deleting all the data in the log.
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366 Several issues were found with log typicals:

1. When “hsDBMaint -clean” is run, and because of an error it cleans up a 
composite log that was a template for a typical, the typical would not be changed 
to reference a different log. Consequently, any database dump done using 
dbConfig would have an invalid configuration because all like statements would 
have an empty log name for the template log.

2. A related issue of log typicals was found in the History Builder. When the builder 
deletes a distributed log that is used as a template, the typical is never changed to 
reference a different valid log, and the same problem with the database dump files 
occurs. 

367 When archive fills up a volume, it starts searching for the next volume where it is 
going to write. If the Jukebox has 16 disks(32 volumes) and if all of them are full, 
archive will mount each one of those 32 individual volumes before choosing the 
one with the oldest last archive time and re initializing it. This process may take up 
to 43 minutes. During this time plus the time it takes to actually write data to disk, 
once the volume is chosen, archive is unusable since no one can view media or 
restore logs with that device.

368 When customers chose to upgrade from IMS2.0 to EH2.2 using an hsBAR tape, 
the UpgradeHistory220 script could fail in a way that would prevent the upgrade 
from working without support from Technical Support. In this particular case, 
orphan records were not removed before the hsBAR was created at History2.2. 
However, for customers that have done this, the upgrade could fail because of 
table space, temp or rollback problems. The real problem is that 
hsConvertDBto240 adds columns to a PDL table before it is converted to 
History2.3 format. This prevents the hsConvertDBto230 from ever being able to 
convert the system with tech support help. The problem can be avoided by 
checking that the tables are at History2.3 before converting to History2.4.

370 Changing individual deadband compaction or engineering range attributes has no 
effect on the collection until history is restarted. However, if all three attributes are 
changed by the builder, collection take place immediately.

Table 7. Problems Fixed by History 2.4 Patch 7

ID Description
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Table 8. Problems Fixed by History 2.4 Patch 7 (BaseHistory):

ID Description

162 The dcALM process returns more values than requested and the values can be 
outside the requested time range. This functionality conflicts with the functionality 
provided by the History Interface.

352 When dual logs are configured in history, the LogManager is expected to use the 
node that is up longer to satisfy a numeric data request. The function that provides 
the boot time of the history server was returning January 1970. This caused all the 
logs to be treated equally, and the lowest sequenced number log (or local) would 
be chosen over a log that could return all the data for the period requested.

360 Originally, hsLogMan was supposed to limit cyclic times for PHL data to be 6 
seconds or faster, even for faster PHL storage rates. In some cases, this is not 
enforced and hsLogMan can set up subscriptions at the PHL storage rate. The 
rates faster than 6 seconds can substantially load down the controller.

Table 9. Problems Fixed by History 2.4 Patch 6

ID Description

173 With history builder, a composite log consisting of two logs was built; Cut Log was 
used to cut a secondary numeric log and create another secondary log which 
received the sequence number 3; the database was dumped using dbConfig. The 
database file failed to load because it was looking for log sequence 2, the 
secondary log that was cut.

214 hsDBMaint -clean function can corrupt a History DB if many logs need cleaning. 
Proper operation of this function will be needed for customers when they are 
configuring a consolidation Enterprise Historian node. Without a GUI for deleting 
many logs, the only painless method is to delete the Composite Logs that you want 
to delete from the object_table and running the hsDBMaint -clean command to 
clean up the other configuration references and the flat files for the logs being 
deleted. Currently, clean can delete wrong objects when run with many (more then 
several) logs that have been deleted from the object_Table.
18 3BUF 001 007 D1



Section 2 Functionality Fixed Problems
 

249 Dropping/Recreating the Oracle Hist DB takes 3 to 5 minutes. This is a long time to 
wait to find out that you had a typo on your command line.

283 Collection and Storage can deadlock on control network node when a 
consolidation node is catching up for a significant amount of time. Significant 
means that each log must catch up 9600 values or more. The threshold for the 
problem may be lower.

304 When moving the mount point with hsBAR, the move fails if the last directory(s) 
are empty. Additionally, if the restore is from file, the file must be in the same 
location it was created for the restore to work.

324 The time checking is too narrow for determining when logs are in difficultly for 
distributed logs. This generates diagnostics when they should not be.

338 When using like statements that specify the log set to be used, dbConfig does not 
report that the logSet specified is not valid when a log set with the same name 
does not exist in a DB file. 

Table 10. Problems Fixed by History 2.4 Patch 5

ID Description

263 The LogManager was not calculating the correct number of values to return. This
resulted in trend displays receiving more values than they could display. This
results in the trace not filling the entire scope of the trend.

275 History requests from DataDirect History Values and sql to Numlogval may get
directed to the CCF Trend Buffer (if it exists) where it will fail because the trend
buffer doesn't support interpolation.

339 The new HSGetDefaultScope interface was preventing any information from being
cached by the logManager (to make subsequent call-ups faster). This fix also
requires the OS group trend element to be corrected.

Table 9. Problems Fixed by History 2.4 Patch 6

ID Description
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Section 3 Installation

Introduction
Please review all the instructions, and your ABB Support terms and conditions, for
precautions, scope of license, restrictions, and limitation of liability and warranties,
before installing this software.

This patch can be applied to systems with Enterprise Historian version 2.2, or 
OS1.8/nPm. The History Services software on the Enterprise Historian or Operator 
Station platform must be at Version 2.4 to install this patch. Refer to the applicable 
update procedure based on the platform where you are installing the patch:

Updating the Enterprise Historian Version 2.2 Platform

Backing Up Your System

It is strongly recommended that you perform a full backup of your system and 
application data before installing any new software. For information on backing up 
your station, please refer to the Enterprise Historian for HP-UX Version 2.2 
Administrator’s Guide.

In case of difficulties, please contact the Technical Support Group 
via SUPPORTLINE: 
in the U.S. - (1-800-HELP-365); 
International - (1-614-224-5888).

History Version 2.4/0 Patch 13 is not removable. It is only being 
released as a patch revision because oracle tables are changing, and 
the changes cannot be removed. Therefore, customers should back 
up their systems before installing this patch update.
20 3BUF 001 007 D1
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Adding /cdrom with sam

If you are installing from CD-ROM, the /cdrom directory must exist before adding 
this patch to the system. Check to see if the /cdrom directory exists by entering 
ls / and looking for the /cdrom directory name. If it does not already exist, follow 
the instructions below for adding the /cdrom directory with sam. If it does exist, skip 
these instructions and continue on to Preparing the CD-ROM for Installation below.

To add the /cdrom directory:

1. In an HP terminal window, log on as the root user by entering: su root

2. Enter sam

3. Within SAM Areas window, select Disks and File Systems

4. Within SAM Areas: Disks and File Systems window, select Disk Devices

5. Within Disk Devices window, select CD from SCSI list of devices

6. Under Actions, Select ‘Add’ -> Not Using the Logical Volume Manager

7. Within ‘Add CD_ROM Disk’ window, enter /cdrom as Mount Directory:

8. In ‘When to mount’ area, deselect ‘Now’. Leave ‘At every system boot’ 
selected.

9. Click OK.

10. File -> Exit

11. File -> Exit SAM.

The following procedures must be performed when you are 
installing the patch from CD-ROM:

• Adding /cdrom with sam on page 21

• Preparing the CD-ROM for Installation on page 22

These procedures prepare the CD-ROM reader to load the patch to 
the local station.

If you received the software depot by some other means, disregard 
these two procedures and go directly to Instructions for Station(s) to 
be Updated on page 22.
3BUF 001 007 D1 21
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Preparing the CD-ROM for Installation

If you are installing from CD-ROM, the /cdrom filesystem must be mounted before 
adding this patch to the system. To see if it is mounted, enter bdf at the UNIX 
prompt, and look for information about the /cdrom filesystem in the command 
output. If the filesystem is not mounted, follow the instructions below to mount it. If 
it is mounted, skip this section and proceed to Instructions for Station(s) to be 
Updated below.

1. In an HP terminal window, log on as the root user

2. Insert the Patch ABB-PHSU_240013 CD-ROM into the CD-ROM drive

3. Enter mount /cdrom

4. Enter: swreg -l depot /cdrom 

This command only needs to be entered one time before loading the first 
station.

Instructions for Station(s) to be Updated

Before installing, you will need to stop all software on the Station (including 
Enterprise Historian software):

1. Open a terminal window and log in as the root user.

Enter su root (super user).

2. Enter /opt/advant/Startup/bin/IMSstop -v

If the mount fails with the following message:
mount: /cdrom was either ignored or not found at 
/etc/fstab, follow the instructions in Adding /cdrom with sam 
on page 21.

If the Station with Enterprise Historian software is shut down in an 
uncontrolled way, the relational database may crash and the data 
may become corrupt. If the station has to be rebooted, use the 
HP-UX shutdown command. This command executes the IMSstop 
script.
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3. If you are loading from a “.depot” file, go to Step 4.

If you are loading from CD-ROM, insert the Patch ABB-PHSU_240013 
CD-ROM into the CD-ROM drive, then

a. Load the patch by entering:

/usr/sbin/swinstall -s <hostname>:/cdrom

b. Go to Step 6.

4. Put the file you have received (ABB-PHSU_240013.depot) on the Enterprise 
Historian, for example under the /tmp directory.

5. Enter: 

/usr/sbin/swinstall -s /tmp/ABB-PHSU_240013.depot

This brings up the “SD Install - Software Selection (station)” window.

6. Under the Actions menu select Match what Target Has.

This will select the proper licensed options on your system to update (including 
History, and/or PDL and/or SPC).

7. Under the Actions menu select Install (Analysis).

8. After analysis is complete, select the Logfile button to bring up the swagent.log 
file. 

<hostname> is hostname or IP address of Advant Station with 
CD-ROM drive attached.

If you get an error dialog indicating that “The current session 
cannot be saved.... Make sure that the HOME Environment variable 
is set”, click OK to continue. This error may occur that this point, or 
later in the process.

Ignore errors regarding fileset dependencies. Exit the dialog to 
continue the installation. 
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Search for the correct date and time heading. Check for any messages that 
begin with ERROR or WARNING. When satisfied, select OK to exit the log 
file.

9. Select OK, then Yes to begin the installation.

10. When the installation has completed, again select the Logfile button to bring up 
the swagent.log file in the window.

Search for the correct date and time heading. Check for any messages that 
begin with ERROR or WARNING. When satisfied, select OK to exit the log 
file.

Select DONE to finish the installation.

11. Under the File menu select Exit to end the swinstall process.

12. If you are loading from CD-ROM, remove the CD from the drive.

13. Execute the swlist command in an HP terminal window to view the History 
version. Verify the version is 02.04.00.13, Figure 1.

14. As root user restart IMS processes. Enter: 
/opt/advant/Startup/bin/IMSstart

15. Perform the post installation procedures as described in Post Installation on 
page 25.

Figure 1. Verifying the History Version

Verify
History
Version
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Post Installation

Log File Update

Whenever a patch is installed on a system, you should edit the Text File 
user_update.log found in the /var/adm/sw directory. At the end of the file, add 
“History Version 2.4/0 Patch 13 Installed”, the date, and description if 
desired. Any other changes made to the product, such as custom memory pool 
changes may also be added. 

The file should be created if it does not exist. You may make the file name more 
application specific, such as user_update_EH2.2-0.log, and rename the file at each 
software update step along the way.

The purpose of the text file is to prevent the deletion of certain user critical changes 
during a reloading or updating of a machine.

For Master Systems with Event Logs Configured

Run a conversion program to correct event entries that were stored incorrectly:

1. Before you run the conversion program, stop IMS processes if not already 
stopped. As root user, enter:
/opt/advant/Startup/bin/IMSstop -v

2. As ocsmgr user, enter: $HS_HOME/bin/hsConvertDBto240 -f

3. As root user restart IMS processes. Enter: 
/opt/advant/Startup/bin/IMSstart

4. Reboot any OS or Enterprise Historian nodes that view History data from this 
node. 
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Updating the Operator Station 1.8/n Platform

Backup

You should backup your Operator Station before upgrading. If necessary, you can 
use this backup to restore your data. For information on backing up and restoring 
your OS, please refer to the Advant® Station 500 Series with AdvaCommand 1.8/1 
AdvaBuild 2.9/0 P2 User’s Guide.

Adding /SD_CDROM with sam

These instructions must be performed to prepare the CD-ROM or DVD-ROM 
reader to load the software to the local station or remote stations. These instructions 
need only be performed one time before loading one or more stations.

The /SD_CDROM directory must exist before adding this update CD-ROM to the 
system.

Check to see if the /SD_CDROM directory exists by entering ls / and looking for it. 
If it does not already exist, follow the instructions below for adding the /SD_CDROM 
directory with sam. If it does exist, skip these instructions and continue on to 
Section , Installation.

These instructions must be performed to add the /SD_CDROM directory.

1. In an HP terminal window, log on as the root user.

2. Enter sam

The following procedures must be performed when you are 
installing the patch from CD-ROM:

• Adding /SD_CDROM with sam on page 26

• Preparing the CD-ROM or DVD-ROM for Installation on page 
27

These procedures prepare the CD-ROM reader to load the patch to 
the local station.

If you received the software depot by some other means, disregard 
these two procedures and go directly to Instructions for Station(s) to 
be Updated on page 22.
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3. Within SAM Areas window, select Disks and File Systems

4. Within SAM Areas: Disks and File Systems window, select Disk Devices

5. Within Disk Devices window, select CD from SCSI list of devices

6. Under menu item Actions, Select ‘Add’ -> Not Using the Logical Volume 
Manager

7. Within ‘Add CD_ROM Disk’ window, enter /SD_CDROM as Mount 
Directory:

8. In ‘When to mount’ area, deselect ‘Now’. Leave ‘At every system boot’ 
selected.

9. Click OK.

10. File -> Exit

11. File -> Exit SAM.

Preparing the CD-ROM or DVD-ROM for Installation

1. In an HP terminal window, log on as the root user

2. Insert the Patch ABB-PHSU_240013 CD-ROM into the drive

3. Enter mount /SD_CDROM

4. Enter: /SD_CDROM/upgrade/register_depot 

This command only needs to be entered one time before loading the first 
station. It registers the directories containing the software to be loaded.

Instructions for Station(s) to be Updated

These instructions must be performed on each station that is to have the update 
installed.

1. If the station you are updating is an X-terminal host, do step a through step d 
before you go to step 2. If the station you are updating is not an X-terminal 
host, go directly to step 2.

a. You need to stop the AdvaCommand software at every X-terminal 
connected to the host. Therefore, at each X-terminal running 
3BUF 001 007 D1 27



Instructions for Station(s) to be Updated Section 3 Installation
 

AdvaCommand remotely from the host, press <Ctrl-D> and enter 
stopsession in the command field.

b. On the X-terminal host station press <Ctrl-D> and enter quit in the 
command field.

c. Suspend the AdvaCommand Auto Startup Interface by clicking on the 
Suspend button.

d. On the X-terminal host, open an HP terminal window.

2. In an hpterm window, Log on as root (super user).

3. Shutdown the Advant Station and X server by entering:

/sbin/init.d/advaCommand stop

This shuts down the Operator Station completely, and after a few seconds the X 
server will shut down.

4. Once the X server is stopped you may have to press the <Enter> key to see the 
login prompt.

5. Log on as root (super user).

6. If you are loading from a “.depot” file, go to Step 7.

If you are loading from CD-ROM, insert the Patch ABB-PHSU_240013 
CD-ROM into the CD-ROM drive, then

a. Load the patch by entering:

/usr/sbin/swinstall -s <hostname>:/SD_cdrom

b. Go to Step 10.

If a USB keyboard is directly connected to a PCI RTAB with USB 
port, a PS2 keyboard MUST be connected to proceed.

<hostname> is hostname or IP address of Advant Station with 
CD-ROM drive attached.
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7. Ensure that all volumes in /etc/fstab are mounted. To do this, compare the 
contents of the fstab file with the output of the bdf command. Comment out any 
volumes that are not mounted.

8. Put the file you have received (ABB-PHSU_240013.depot) on the station 
where you are installing the patch, for example under the /tmp directory.

9. Enter: 

/usr/sbin/swinstall -s /tmp/ABB-PHSU_240013.depot

This brings up the “SD Install - Software Selection (station)” window.

10. Under the Actions menu select Match what Target Has.

This will select the proper licensed options on your system to update (including 
History, and/or PDL and/or SPC).

11. Under the Actions menu select Install (Analysis).

12. After analysis is complete, select the Logfile button to bring up the swagent.log 
file. 

Search for the correct date and time heading. Check for any messages that 
begin with ERROR or WARNING. When satisfied, select OK to exit the log 
file.

13. Select OK, then Yes to begin the installation.

14. When the installation has completed, again select the Logfile button to bring up 
the swagent.log file in the window.

Search for the correct date and time heading. Check for messages that begin 
with ERROR or WARNING. When satisfied, select OK to exit the log file.

Select DONE to finish the installation.

If you get an error dialog indicating that “The current session 
cannot be saved.... Make sure that the HOME Environment variable 
is set”, click OK to continue. This error may occur that this point, or 
later in the process.

Ignore errors regarding fileset dependencies. Exit the dialog to 
continue the installation. 
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15. Under the File menu select Exit to end the swinstall process.

16. If you are loading from CD-ROM, remove the CD from the drive.

17. Execute the swlist command in an HP terminal window to view the History 
version. Verify the version is 02.04.00.13, Figure 2.

18. Enter the reboot command:

reboot

19. At the Operator Station Startup Interface window, open HP terminal windows 
as required to complete Finishing Instructions on page 30. Exit all HP terminal 
windows when done.

20. Follow the start-up procedures as described in Advant Station 500 Series with 
AdvaCommand 1.8/1 / AdvaBuild 2.9/0 P2 User’s Guide.

Finishing Instructions

These instructions must be performed to remove the CD-ROM from the reader after 
loading the upgrade to the local station or remote stations.

1. In an HP terminal window, log on as the root user

2. Enter umount /SD_CDROM

3. Remove CD-ROM from the reader.

Figure 2. Verifying the History Version

Verify
History
Version
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Log File Update and Review

Whenever an upgrade is installed on a system, you should check for ERROR in the 
following text files. Further checks can be reviewed the swinstall.log and 
swagent.log.

Optional User Log

At the end of the user_update.log file, add the upgrade names that you have 
installed, the date, and description if desired. Any other changes made to the 
product, such as custom memory pool changes may also be added. 

The file should be created it if it does not exist. You may make the file name more 
application specific, such as user_update_os1.8-1.log, and rename the file at 
each software update step along the way.

The purpose of the text file is to prevent the deletion of certain user critical changes 
during a reloading or updating of a machine.
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